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CHAPTER 1 DATA RECORDING AND ARCHIVING
Data Recording and Data Archiving is used to create a record of selected fields from an instrument. The recorded field
values can be archived and displayed at a later date. The purpose is to provide

n  General audit records (for subsequent analysis with MS Excel, for instance)

n  Quality control of product and plant

n  Performance monitoring

The main sections are how to

n  Data recording in the instrument strategy

n  Data archiving in the instrument strategy

The recorded data can then be displayed on a chart using Review.

Note The following instructions assume the FTP Server has already been installed. However, instructions for
installing an FTP Server are supplied in Appendix A.

1.1 WHAT ARE DATA RECORDING AND DATA ARCHIVING ?

Recording data is the process of writing groups of values, data recording groups, of selected block fields in the
database to Data Recording files, .uhh, in an instrument’s non-volatile internal flash memory. This memory is
maintained during a power outage. The data stored in the .uhh files can be examined using Review.

Note The Data Recording configuration is only applied after the configuration has been downloaded with
the database file, .dbf.

Archiving data is the process of pushing the recorded values from the internal flash memory to .uhh files in an archive
directory on an FTP Server. FTP is a commonly used file transfer mechanism. An instrument will operate as an FTP
Client to up to three FTP Servers for the purpose of transferring .uhh files from the instrument to a remote computer
using FTP. Archived .uhh files can be automatically imported in to Review from the directory on the configured FTP
Server, see FTP (File Transfer Protocol) Server section.

n Displaying data is the process of creating a chart from the .uhh files stored in the FTP Server. A chart can be
output as an electronic file, and/or a printed hard copy providing a physical record of the selected field values
recorded in the instrument.

Note Review can be configured to pull files directly from the instrument, but this is not recommended.
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1.2 QUICK START TO DATA RECORDING

These instructions assume that the instrument firmware and the required Licence (D10 to D90) are already installed.

To configure the instrument data recording,

1 Open the database file, .dbf, of the instrument using LINtools Engineering Studio. Click

a  Start > Programs > ... > LINtools Engineering Studio

Note The Get me started dialog may appear if
LINtools was not opened via a .dbf. This
dialog allows you to use one of the more
common options when starting LINtools.

When the .dbf opens, the blocks are displayed on
the worksheet and the Data Recording
Configurator icon appears in the Contents pane,
and allows more precise configuration of fields.

2 Open the block to display the block fields in the
Object Properties pane. Select the required field
and right-click to display the context menu.

l Alternatively, select the Block containing the
fields that you want to record, and right-click to
display the context menu.

3 Select the Add to Data Recording command, then
the New Group command from the context menu.

4 A New Group dialog appears. Enter a name and
press OK to confirm.

The name is used to identify the data recording
group when displaying selected values.

5 When the group name is confirmed, the DataRec compound automatically
appears on the .dbf worksheet. It contains all the blocks required for Data
Recording, an RGROUP block used for controlling and managing the associated
data recording group, and two diagnostic blocks used to help if problems occur.

l If a specific field was selected, it will be recorded in this group.

l If a block was selected, a default selection of its’ fields will be recorded in
this group.

6 Select the Data Recording Configurator icon, then the Fields page to show the
fields that will be recorded, as below.
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1.2 QUICK START TO DATA RECORDING (Cont.)

Data Recording and Data Archiving are configured using LINtools Engineering Studio. The Data Recording features
are enabled in LINtools when data recording is supported by the instrument. Additional Groups can be added using a
context menu from a Block or Field in the database, or via the Groups page in the Data Recording grid. Fields are
added to Data Recording Groups using a context menu command in the database editor or from the Blocks page, or
Field page in the Data Recording Configurator. The completed configuration is saved and automatically downloaded
with the database file, .dbf.

Note The context menu also alows a selected Data Recording Group to be deleted or a data value to be
removed from a data recording group.

To support Data Recording, a DataRec compound is automatically created when the first field(s) is selected. It
contains all blocks required for data recording, an RGROUP block, an RARCDIAG block and an RMEMDIAG block.

n The RGROUP block provides run-time control and monitoring of the Data Recording, and identifies an individual
Data Recording Group. Each group of recorded values is associated with a single RGROUP block.

n The RARCDIAG block provides monitoring and diagnostics information for both primary and secondary modules
of an I/O subsytem when archiving recorded data to a specified FTP Server via FTP.

n The RMEMDIAG block provides monitoring and diagnostics information about the flash memory in both primary
and secondary modules of an I/O subsytem used for historical storage of recorded data.

The Data Recording and Data Archiving process is shown below.

Figure 1-1 Data Management Configuration

LINtools operating on computer

Review operating on computer
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Configure, download
and monitorstrategy
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1.3 QUICK START TO DATA ARCHIVING

The image shown here is an example of how the Instrument Options page should appear when finally configured.

To configure the instrument data archiving,

1 Select the Instrument configuration folder in
the Contents pane in LINtools Engineering
Studio, and right-click to display the context
menu. Select the Properties command to
open the Instrument Properties dialog.

2 The Instrument Properties dialog appears.
Select the Instrument Options page to
display the configuration parameters for
various aspects of the instrument, e.g. HMI
settings, Modbus or Profibus ports
configuration, etc.

3 Select the Archiving category. This shows parameters associated with archiving configuration.

Define the FTP Servers as required, i.e. FTP Server 1, FTP Server 2 and FTP Server 3.

l Enable the Use FTP Server 1. Set this
TRUE to enable the recorded values to
be archived to the FTP Server configured
at the specified IP address (HostIP), see
FTP (File Transfer Protocol) Server
section.

l Set the Host IP. This is the IP address of
the FTP Server.

l Set the Directory path. This is the
directory path to the archive directory in
the defined FTP Server.

l Set the User Name. This is the user
name required to access the archive
directory in the defined FTP Server. This
is used in conjunction with the password
configured below (Password).

l Set the Password. This is the password
associated with the corresponding User
Name required to access the archive
directory in the FTP server. This displays
the Enter New Password dialog.

Note The example shows a Tom Smith Windows User account is being used to access the FTP Server when
archiving the .uhh files.
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1.3 QUICK START TO DATA ARCHIVING (Cont.)

4 Press OK to confirm the changes to the instrument configuration. Before the Instrument Properties dialog can
close further dialogs appear.

l A dialog is displayed requesting that the changes are downloaded to the instrument. Press Yes to
confirm.operate as a duplex unit synchronise the primary and secondary modules.

Note Inspect the RARCDIAG block in the DataRec compound to diagnose problems that occur when
archiving, see Troubleshooting section.

The  following image is an example of how the .dbf and Instrument Properties dialog should appear.
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1.4 HOW TO...

In this section, you will be guided through additional tasks used to configure the recording. These tasks will help you
when configuring the data recording in the instrument, and include instructions for  changing how a field will appear
when displayed on a chart, and creating a chart.

1.4.1Add fields to a data recording group

Further fields can be added to existing data recording groups, or to new groups. As fields are added and new groups
are created the recording time of each group in the instrument will reduce, as shown in the (Est.) Memory Duration
column on the Groups page of the Data Recording grid.

The Add to Data Recording command is available on a context menu when,

n  single or multiple compounds or blocks are selected in the Function Block Diagram, or the Block list view

n  A field is selected in the Object Properties pane

n  single or multiple compounds, blocks, or fields are selected in the Find dialog

Default fields and specific fields can also be added to a data recording group using a picklist available from the Blocks
page and Fields page of the Data Recording grid, respectively.

If the command is selected from a compound or block, a default selection of fields from the block(s) will be added to
the specified data recording group. The default selection will always include all the Alarms in the block. You can also
add all the default selection of fields from multiple blocks by selecting multiple compounds or blocks.
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1.4.1 Add fields to a data recording group (Cont.)

If the command is selected from a field in the Object
Properties pane, only the selected field will be added to the
data recording group.

Using the Find dialog allows you to quickly find and select a field with the same or similar name in multiple blocks
and add them to the data recording configuration. This is an easy way to quickly add many fields to the recording,
e.g. after finding all the PV fields in the database, you can add them all to the recording with one click. This allows
you to add the,

n default fields of blocks that matched the search criteria

n only specific fields that matched the search criteria

Note You can also add blocks and fields to the recording using the Blocks page or Fields page of the Data
Recording Configurator, as appropriate.
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1.4.1 Add fields to a data recording group (Cont.)

When the Data Recording grid is open, you can use the Blocks page to add default fields to the first available data
recording group.

n Select the Blocks page to show information about each block in the recording.

n Block Name column shows the names of recorded blocks.

Click the Add block field and select the required block from the picklist displayed. This adds a default selection
of the blocks’ fields.

When the required block is selected, the Recorded Alarms shows All . This indicates that all Alarms for this block
will be recorded. Recorded Alarms is set to All  by default, but specific alarms can be configured by editing fields
on a dialog displayed when the Recorded Alarms field is selected.

The associated block information is displayed in the Object Properties pane.

When the Data Recording grid is open, you can use the Fields page to add specific fields to the first available data
recording group.

n Select the Fields page to show individual display information about each specific block in the recording.

n Field Name column shows the names of recorded block fields.

Click the Add field field and select the required block field from the picklist displayed. This adds the block field
to the data recording, for the first Data Recording Group available.

Note While this page is displayed, you
may want to configure the
appearance of the selected field
when it is displayed on a chart.

You can remove fields from the data recording
configuration by right-clicking the field in the
Object Properties pane or the Find dialog and
selecting Remove from Data Recording
command. You can also select compounds and
block in the Function Block Diagram, or the
Block list view and use the Remove from Data
Recording command to remove all the selected
blocks’ fields from the specified data recording
group.
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1.4.2Change the data recording group

When the Data Recording grid is open, you can use the Blocks page, see below, to change the data recording group of
default fields.

n Select the Blocks page to show information about each block in the recording.

n Group column lists all Data Recording Groups in the instrument strategy. Click the associated Group field and
select the required Data Recording Group from the picklist displayed. The fields will be recorded in the specified
group after the configuration has been downloaded.

1.4.3Configure the recorded Alarms

The Blocks page of the Data Recording Configurator in LINtools provides the ability to edit the block
configuration, to specify which alarms should be recorded for each group.

n Select the Blocks page to show information about each block in the recording.

n Select the relevant Recorded Alarms field to reveal the Select alarms to record dialog. This dialog provides the
selection of individual Alarm parameters from the selected block.

Set Record All  to indicate that all Alarms will be recorded.

Set individual Alarm parameters  to indicate that only the defined Alarms recorded.

This column shows the Alarm parameters that will be recorded for this block.

When the Data Recording grid is open, you can use the Fields page, see below, to change the data recording group of a
specific field.

n Select the Fields page to show individual display information about each specific block in the recording.

n Group column lists all Data Recording Groups in the instrument strategy. Click the associated Group field and
select the required Data Recording Group from the picklist displayed.
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1.4.4Configure the appearance of recorded field

The Fields page of the Data Recording Configurator contains parameters used to configure the default appearance of a
recorded field, when displayed on a chart.

Editing the parameters on this page allows you to define how you want the trend to be displayed in Review.

Note These parameters may not have to be configured because LINtools and Review automatically layout
the trends with default parameters.

n Field Name column shows the names of recorded block fields. Use the relevant field to change or add a field to
the recording.

n Group column shows the Data Recording Group in which each field is recorded. Use the relevant field to change
the data record group of the field to the recording.

n Description fields show a description used to identify the associated field value when displayed in Review. The
description can be up to 16 characters, but must be unique within a group. You can change the default block.field
name by clicking this field and entering a the required text.

n Format fields show the format of the associated field value when displayed in Review. The format selection is
dependant on the block.field type. You can change this by clicking this field and selecting the required format
from the picklist.

n Colour fields show the colour of the field value (trend) when displayed in Review. You can change this by
clicking this field and selecting the required colour from the picklist.

n MinMax fields enables (On) or disables (Off) the MinMax recording for the field. This operates by measuring
the input signal each time the block is updated, and saving the maximum and minimum values at the end of the
period of trend update. When the trend is updated, both maximum and minimum values are traced on the chart, i.e.
two traces are produced for the value.

You can use MinMax to record the minimum and maximum values of a field over the sample period rather than a
sample at the end. If MinMax is OFF, during slow recording speeds it is possible that the field, between samples
will pick up a spike or brief disturbance in the value, but that this disturbance will not be recorded, even though it
may trigger an alarm.

If MinMax is On, recording intervals can be slowed while any spikes or anomalies in the field will still be
recorded. However, the associated value counts as two trends in Review and uses twice as much memory as
normal recording.

Actual input signal

Normal trace

MinMax trace

MinMax bar
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1.4.4 Configure the appearance of recorded field  (Cont.)

The following example shows the SpanLow and SpanHigh, and ZoneLow and ZoneHigh parameters configured for
TC001.PV. SpanLow and SpanHigh is set from -10°C to 50°C showing the span of the recorded value, and the
ZoneLow and ZoneHigh is set from 50% to 100% showing the trace is displayed in the top half of the chart.

n SpanLow and SpanHigh fields define the span,
in engineering units, displayed in Review.
SpanLow values are displayed at ZoneLow, and
SpanHigh values are displayed atZoneHigh. If
required, SpanLow can be configured with a
higher value than SpanHigh to invert the trace.

n ZoneLow and ZoneHigh fields define the zone
on the chart that the trace will be restricted to in
Review.

n Active and Inactive fields define text strings to represent the digital zero (0) or non-zero (1) recorded value. This
is only relevant to fields recorded in a digital format. By default Active is set TRUE and Inactive to FALSE. You
can change these to any 16 character value.

1.4.5Configure the visualisation options

The Options page contains parameters used to allow customisation of individual values in the Data Recording
Configuration.

n Configure the Show Visualisation Parameters for fields. Use this to display additional parameters that provide
control of visualisation parameters that appear on the Fields page.

n Configure the Instrument area name fields. These options
are used to identify the Data Recording Groups configured
in this instrument. The Instrument area name
configuration is shown in Review when creating a chart.

When Use default name for instrument area is selected,
the data recording group name shown in the Name field in
the RGROUP block remains as the name entered when the
data recording group was created, but during run-time it is
prefixed with the network name, node address, and
Configuration (Header) block name,
e.g. ELIN_01:14:T2550_14.

When Use custom name is selected, the associated entry
precedes the data recording group name shown in the, Name
field in the RGROUP block, and the name entered when the
data recording group was created. This provides a greater
level of identification of the parameters selected for data
recording when using Review.

ZoneHigh = 100%
SpanHigh = 50°C

ZoneLow = 50%
SpanLow = -10°C

Chart = ZoneHigh = 100%
ZoneLow = 0%
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1.4.6Chart recorded data

Data Recording files, .uhh , can be displayed as a trend chart using Review.

Note Review can be used to generate graphics and/or .csv files for display and printing of .uhh files, see
Review Help file, Part no. HA 027 962 and/or the User Guide for full details.

Review can be configured to transfer .uhh files to a Review database at scheduled intervals. The Review database
provides a means of displaying  multiple .uhh files containing the recorded data values.

To configure the scheduled transfer of .uhh files

1 Launch Review. Click a  Start > Programs > ... > Review

Note ‘...’ denotes the default installation path.

2 Select File > Transfer > Scheduled Transfer... to display the Scheduled Transfer from Folders dialog used to
configure the transfer of .uhh files.

l Set Run as Service TRUE. This
will run Review in the background
automatically adding the .uhh files
to the database. The computer user
name and password will be
requested for the account to be used
to run the service.

l Configure the Source Archive
Folder. For a local FTP directory,
use the full path; for example,
c:\inetpub\ftproot , by default if
using IIS FTP Server, but this
may also include an additional
folder used to identify the
instrument. Use the Browse
button to select a local directory
rather than typing the path.

l Enable the transfer of .uhh files. Set TRUE to allow the transfer of .uhh files from the defined Source Archive
Folder to the Review database to be carried out automatically using the criteria defined in the AUTOMATE area.

l Configure the AUTOMATE section parameters. Enter the Next Run period. This is the day number and time
for the first transfer to occur, automatically updating after each transfer, according to Repeat every, i.e. in the
example scheduled transfers occur every day at 1 a.m., starting on the 14th of the month. Set the Repeat
every period, to define the repeat period for Scheduled Transfer, starting from the time and day number
specified in Next Run. Set Also run immediately new file detected TRUE if required. This causes Review
to check the instrument, every minute, for new files.  If a new file is detected, a transfer occurs immediately,
irrespective of the automatic repeat rate setting.

Note If Repeat every is set to 0, and Also run immediately new file detected is TRUE, a transfer occurs only
when a file is closed and a new one opened, and only the closed file(s) transferred.  This means that
each file is transferred (and .csv files generated) only once.  If Repeat every is not set to 0 and Also
run immediately... is TRUE, the scheduled transfer causes all files (including open ones) to be
transferred, but intermediate transfers, triggered by new file detection, transfer only closed files.

3 Press OK to confirm the configuration, and display the Service Logon dialog. Enter the computer user name and
password of the account to be used to run Review as a service and, press OK to confirm this information. This
will add the Review icon to the system tray on the computer.



HA029723
Issue 2  Nov 12

Chapter 1
Page 1 - 13

T2550 PAC TUTORIAL/USER GUIDE

1.4.6 CHART RECORDED DATA (Cont.)

To produce a chart

1 Select File > New Chart.... The Chart Setup dialog is displayed and provides parameters used to configure the
new chart.

2 Press the Add Point button to display the Select Point dialog. This allows the selection of the instrument, data
recording (Log) group and individual recorded values.

l Select the Instrument . This is the instrument containing recorded values that can be displayed. Select the
instrument from the menu. This is derived from the default instrument name or the custom name configured
on the Options page in the Data Recording Configurator in LINtools.

l Select the Log Group. This is the data
recording group in the instrument containing
recorded values that can be displayed. Select
the data recording group from the menu.

l Select the Point ID(s). These are the
recorded fields in the specified data
recording group of the defined instrument.
Select the recorded fields that you wish to
display, using the <CTRL> key to select
multiple recorded fields, or the <Shift> key
to select a group of recorded fields and
confirm using the OK button, or press the
Add All button to select all the recorded
fields and automatically confirm the
selection.

3 Press the OK button to confirm the changes, then press OK to confirm the display of the chart.
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1.5 TROUBLESHOOTING

Most data recording and data archiving problems can be resolved by inspecting the RMEMDIAG block and the
RARCDIAG block.

Note Most of the following instructions can be tried and applied during online reconfiguration. If
configuring the instrument strategy offline, remember it must be saved and downloaded to the
instrument before confirming the operation.

Q Why does the Data Recording Configurator not appear in LINtools ?

A This is probably because you are upgrading an instrument. The Data Recording Configurator will only appear if
the instrument firmware version supports data recording. To resolve this,

l Ensure the instrument firmware version 4.0 or later is installed in the base unit.

Note If updating from an existing .dbf, remember to change the instrument header block. Simply delete the
existing header block, then drag and drop a Tactician type Configuration block, version 4.0 or later to
the worksheet. Finally, rename the new header block to match the name used by the header block that
was deleted. Build and download the instrument strategy.

Q Can I change the recording rate of a data recording group ?

A The recording rate is configured using the UpdateA field in the RGROUP block in the .dbf, and applies to all
fields in that data recording group. To change this,

l Open the Database configurator, find and select the RGROUP block corresponding to the data recording
group. Edit the UpdateA field value, and press <CR> to confirm the changes. Changing this value adjusts the
intended time period between recording samples.

Q Can I record fields that change rapidly while recording at a slow update rate ?

A If you have decreased the update rate of a data recording group, and have fields that change rapidly, short duration
spikes (for example) may not be recorded. Enabling the MinMax function, ensures that these fields can be
recorded at slow recording speeds. If you want to record fields that change rapidly at slow recording speeds.

l Open the Data Recording Configurator and select the Fields page, then select the MinMax field associated
with the required value to display a picklist, and select ON to enable this function.

When MinMax is enabled the minimum and maximum values of the field are recorded and saved at the end of
each recording period. When the trend is shown in Review, both maximum and minimum values are displayed on
the chart, i.e. two traces are produced for specified field.

When enabled, this counts for 2 of the 127 maximum trends in Review.

Q What do the question mark and asterisk characters in a message appearing in Review mean ?

A These characters are used to indicate that the time value in a message is derived from a remote instrument and
may potentially be unreliable. The remote instrument does not provide a date. The * characters appear because
you are recording alarms of a block cached from an instrument that is not time synchronised to the local
instrument.
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1.5 TROUBLESHOOTING (Cont.)

Q Can I define the position and limits of a recorded field when displayed in Review ?

A In Review, a chart is divided in to zones that can be displayed adjacently or overlaid, depending on the
configuration defined in the dialog displayed when the Settings command from the Options menu is selected.
The Point Properties dialog shows the position and limits of a recorded field. These are derived from the
SpanHigh and SpanLow, and ZoneHigh and ZoneLow columns configured in the Data Recording Configurator.

l ZoneHigh and ZoneLow specifies the position of the trend on the chart, e.g. settings of 50% and 100% cause
the trend to appear in the top half of the chart.

l SpanHigh and SpanLow specifies the limits, in engineering units, of the zone to which the selected trace will
be scaled.

Note If an inverted 0 is required then set SpanLow larger than SpanHigh. This will invert the trend in the
zone.

ZoneHigh

ZoneLow

SpanHigh

SpanLow
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1.5 TROUBLESHOOTING (Cont.)

Q Why is data recording not working ?

A This could be due to one of many problems, some depending on whether configuring a new or existing database.

Use this flow chart to diagnose the problem.

Set RGROUP.Enabled TRUE, or
enable recording via the Enable

Recording field in the Data
Recording configurator.

Data Recording

Define block fields that are to
be recorded. Ensure the
fields appear in the Data
Recording Configurator.

Is
RGROUP.Enabled

TRUE ?

No

Open
the RGROUP block.

Is RGROUP.Status.Recordng
TRUE ?

No Yes

Is
RGROUP.Id

configured ?

No

Set RGROUP.Id  greater than
0 (zero). 0 disables the
operation of the data

recording group.

Yes

No YesAre any alarms
in the RGROUP block

TRUE ?

Install valid hardware, valid
licence (see OPT_DIAG block),
and create a recording group

corresponding to the Id.

Reset alarm flags.
Set each RGROUP.Reset

subfield TRUE.

No Is
RGROUP.Alarms.Config

TRUE ?

Yes

The hardware does not
support Data Recording
and must be replaced.

No Is
RGROUP.Alarms.MenHW

TRUE ?

Yes

No Are any other
RGROUP.Alarms  bitfields

TRUE ?

Yes

Any other alarm will not
affect the Data Recording,
see LIN Block Reference

Manual .
No Are any

RMEMDIAG.Alarms  bitfields
TRUE ?

Yes

The alarms in this block show
the condition of the hardware

and flash memory, see LIN
Block Reference Manual .

Reset alarm flags.
Set each RMEMDIAG.Reset

subfield TRUE.

You are now recording.
Check the archive

configuration.

A

No Is the required
update rate configured ?

Yes

Set RGROUP.UpdateA (or
RGROUP.UpdateB  if

RGROUP.SelectB is TRUE)
≥ ≥ ≥ ≥ ≥ RGROUP.ActUpdat

See data archiving flowchart , if you
are recording but files are not

appearing in the archive directory.
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1.6 TROUBLESHOOTING (Cont.)

If RARCDIAG.Alarms.PrHst1Er
is TRUE, check subfields in

RARCDIAG.PrError1 .

A

Data Archiving

Install and configure the
FTP Server, see FTP (File
Transfer Protocol) Server .

Is
the FTP Server installed ?

No Yes

Open the installed
FTP Server

archive directory.

Do data
recording files (.uhh)
appear in the archive

directory ?

No Yes

Is
Archiving configured

in the Instrument Properties
dialog ?

No Yes

Configure Archiving in the
Instrument Properties  dialog,

see Quick Start To Data
Archiving . Are any

alarms in the
RARCDIAG block

TRUE ?

No Yes

No

No

No

No

No

No

IP address in Instrument
Properties dialog cannot be found
on network. Consult the engineer
who configured the FTP Server.

Is
RARCDIAG.PrError1.BadPing

TRUE ?

Is
RARCDIAG.PrError1.Connect

TRUE ?

Check FTP Server is running.
Consult the engineer who
configured the FTP Server.

Is
RARCDIAG.PrError1.Login

TRUE ?

Invalid Login details in
Instrument Properties dialog.

Consult the engineer who
configured the FTP Server.

Is
RARCDIAG.PrError1.Dir

TRUE ?

Invalid archive directory path in
Instrument Properties dialog.

Consult the engineer who
configured the FTP Server.

Is
RARCDIAG.PrError1.Access

TRUE ?

Archive directory is read-only.
Enable Write access.

Consult the engineer who
configured the FTP Server.

Yes

Yes

Yes

Yes

Yes

Yes

Repeat this for each alarm
subfield ( Alarms.PrHst2 to

Alarms.SeHst3 )
as it occurs.

No Yes

The FTP Server failed
while writing files.

Consult the engineer who
configured the FTP Server.

Files were deleted before being
archived. Slow the Update rate

(RGROUP) or increase the
Interval rate, see Archiving .

Is
RARCDIAG.PrError1.Access

TRUE ?

Is
RARCDIAG.PrError1.Access

TRUE ?

If problems persist,
contact help desk.

You are now archiving.
Check the Review
configuration, see

Chart Recorded Data .

Reset error flags.
Set RARCDIAG.RstDiags

TRUE.

See data recording flowchart , if you
are not recording.
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CHAPTER 2 SETPOINT PROGRAM
This section describes the Setpoint Programmer facility supported by this instrument.

The purpose of a Setpoint Programmer is to control and manage the target value that an automatic control system,
e.g. PID controller, will aim to reach.

Example

A boiler control system might have a temperature Setpoint, that is a temperature the control system aims to attain in the
system.

The main topics covered are as follows:

n Setpoint Program Configuration (section 2.1)

n Quick Start To Configuring Setpoint Programming Blocks (section 2.2)

n Quick Start To Configuring  A Channel Profile (section 2.3)

n Quick Start To Controlling A Program (section 2.4)

n How To... (section 2.5)

n Troubleshooting (section 2.6)

2.1 SETPOINT PROGRAM CONFIGURATION

The Program Template file (.uyw) describes the structure of a Programmer, the number of Channels and corresponding
names, the number of Digital Events, Wait Conditions, Exit Conditions, and User Values, and how each Channel is
presented in the Programmer Editor. The description contained in the Program Template file is then used to ensure the
Program file (.uyy) corresponds to each Programmer’s structure. The names of individual process variables (Profiled
Channels), digital event outputs and user values defined in the Program Template file are all shown in the Programmer
Editor used to generate the Program. The Program Template file must be modified using the Programmer Wizard in
LINtools.

The Program Template file can be referenced by a local instrument or any other instrument on the same network. This
allows the same Program Template file to apply to multiple instruments.

The following diagram shows all system configuration components required for a Programmer application.

Computer Instrument Folder

Instrument Folder

Program
file

(.uyy)

Database
file

(.dbf)

Programmer
Wizard

Download to
instrument

To/From Process

T2550

Programmer
Editor

To/From Process

T2550

Download to
instrument

LINtools
Engineering Studio

Note This configuration could equally apply to the T820 Controller variant.

Program
Temlate

file
(.uyw)



T2550 PAC TUTORIAL/USER GUIDE

Chapter 2
Page 2 - 2

HA029723
Issue 2  Nov 12

2.1.1 Programs

This instrument supports single and multi-channel Programs. This is defined by the number of Name entries in the
Profiled Channels page of the Programmer Wizard. The Chart pane in the Programmer Editor shows a maximum of
three Profiled Channels, the first two Name entries in the Programmer Wizard correspond to the two most upper
Profiled Channels the other Profiled Channel displayed in the lowest Chart position is the one selected in the Segment
grid. The lowest Chart position can also show a Digital Event Output, or User Values by selecting it from the
Properties pane, see below.

n A single channel Program, i.e. the control of one input value from the plant/system, supports Step, Dwell,
RampRate, RampTime, and End Segment types. The Profiled Channel appears in the upper most Chart position,
allowing Digital Event Output, and User Values to be displayed in the remaining Chart positions.

n A multi-channel Program, i.e. the control of more than one input value from the plant/system over an identical
time period, supports Step, Dwell, RampTime, and End Segment types, but does not support RampRate Segment
type. The first two Profiled Channels always appear in the upper most Chart positions in the order defined in the
Programmer Wizard, and in the lowest Chart position displays the selected information as stated above.

The following image shows a multi-channel program.

Chart Pane
Program

Properties Pane

Segment Grid
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2.2 QUICK START TO CONFIGURING SETPOINT PROGRAMMING BLOCKS

These instructions assume that the instrument is correctly wired to the plant/system and is operating normally, the database
file, .dbf is already open, and all existing blocks and compounds are displayed on the worksheet.

Note For the purpose of this exercise, we will only configure one PID control loop to one Profiled Channel.
If using multiple PID control loops in the strategy, wire each PID control loop to a PROGCHAN block.

1 Launch the Programmer Wizard from the Tools menu.

The Programmer Wizard is used to
configure a Program Template file and
create and edit the blocks in the
PROG_WIZ compound.

Note Block fields are described using
blockname.page.field.subfield
format. Pages have been used in
some blocks to increase the
number of required fields, but
are only visible in the Object
Properties pane.

2 Complete each page, providing as much information as necessary to configure the Program Template file and the
PROG_WIZ compound. For the purposes of this exercise set

n Make new PROGCTRL block to SP01

n Program Template file to T2550_14

n 3 Profiled Channels (My_PV01,
My_PV02, and My_PV03)

n 4 User Values (UserVal_01 to
UserVal_04)

n 16 Digital Events (Dig_Event_01 to
DigEvent_16)

n 8 Wait Conditions (Wait_01 to Wait_08)

n 8 Exit Conditions (Exit_01 to Exit_08)

n RampBack power fail recovery action

The Program Template file defines the constraints of a Program file for an instrument and how each channel profile is
presented in the Programmer Editor and instrument.

The PROG_WIZ compound contains 1 PROGCTRL block, up to 8 PROGCHAN blocks, and up to 8 SEGMENT
blocks per PROGCHAN block.

Note All blocks created using the Programmer Wizard are automatically named using the prefix defined on the
PROGCTRL Name page.

IMPORTANT To prevent erroneous
Program Template file configuration always use
the wizard to edit the blocks in the PROG_WIZ
compound. Changing the number of Profiled
Channels, Digital Events, or User Values will
invalidate any Program files created with the
previous version.
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2.2 QUICK START TO CONFIGURING SETPOINT PROGRAMMING BLOCKS (Cont.)

3 Connect the control loop to the appropriate Setpoint Program Channel. Start with the PV output from the
LOOP_PID block to the PROGCHAN block.

i) Select the LOOP_PID block and display
the Object Porperties pane. Click the PV
field to reveal the context menu shown.

ii) Select the Connect output to... command
to display the picklist of available blocks.

iii) Locate and expand the PROGCHAN
block, then select the PV field.

4 Add the remaining wiring connections shown below. Table 2-1 lists all the source and destination fields that
should be interconnected in this strategy, and summarises their functions. Repeat for each Program channel.

Note The following table uses a (Block type)
blockname.page.field.subfield format
to show source and destination wiring.
Pages have been used in some blocks
to increase the number of required
fields, but are only visible in the
Object Properties pane.

Source Destination Function

Control Loop configuration

(AI_UIO) PV.PV (LOOP_PID) loop_pid.Main.PV Process Variable (PV) from the T2550 input module
in to the LOOP_PID block. For testing purposes, this
can be sourced from the PV field of a SIM block.

(LOOP_PID) loop_pid.Main.WrkOP (AO_UIO) OP.OP PID control output OP to the T2550 output module

Programmer configuration

(LOOP_PID) loop_pid.Main.PV (PROGCHAN) SP01C1.Monitor.PV PID control loop PV in to the Programmer channel
(PROGCHAN) block for using the control loop PV

(LOOP_PID) loop_pid.Main.WSP (PROGCHAN) SP01C1.Monitor.SP PID working setpoint in to the Programmer channel
(PROGCHAN) block for the operating setpoint of the
control loop

(PROGCHAN) SP01C1.Monitor.CurrSP (LOOP_PID) loop_pid.SP.AltSP Current setpoint generated by the locally-running
setpoint program in to the LOOP_PID block’s remote
setpoint input

(PROGCHAN) (LOOP_PID) loop_pid.SP.AltSPEn Enables the use of an setpoint. This is not a setpoint
configured locally in the LOOP_PID block.

Table 2-1    Strategy wiring data

SP01C1.Monitor.StateFlg.ChActive
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2.2 QUICK START TO CONFIGURING SETPOINT PROGRAMMING BLOCKS (Cont.)

5 Edit the block fields. The following table lists the fields that should, as a minimum, be edited from their default
values. Most PROG_WIZ compound block fields are automatically populated via the Programmer Wizard. For
completeness, all edited fields are shown in the table.

Note For the purpose of this exercise, we will only configure one PID control loop to one Profiled Channel.
Repeat this for each PID control loop as required.

Block.Page.Field.Subfield Value Function

Control Loop configuration

(LOOP_PID) loop_pid.PID.TI1 5.00 Sets the PID integral time constant to 5 seconds, to improve control

(LOOP_PID) loop_pid.Alarms.Lo 20.00 Sets the loop_pid’s PV output ‘low absolute’ alarm at 20. The
loop_pid.Main.Alarms.Lo is asserted when loop_pid.Main.PV falls
below 20.

(LOOP_PID) loop_pid.Main.Alarms.Lo 1 Enables the ‘low absolute’ alarm on the loop_pid’s PV output

Programmer configuration

(PROGCTRL) SP01.File.ProgFile T2550 Shows the name of the Program file associated with the Program
Template file shown in (PROGCTRL) SP01.File.TmplFile.

Table 2-2    Values for non-default block fields

You should now have configured the database to control the setpoint of one PID loop.

The following figure shows a single PID control loop and the wiring to a PROGCHAN block within the PROG_WIZ
compound. This represents a single Profiled Channel in the Programmer Editor.
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2.3 QUICK START TO CONFIGURING A PROGRAM

These instructions assume that the database file, .dbf is already open, and all existing blocks and compounds are
displayed on the worksheet.

1 Launch the Programmer Editor from the Tools menu in LINtools. Alternatively, use

a  Start > Programs > ... > Programmer Editor  > Programmer Editor

n If the Program file does not exist,
select File > New to display the
Choose a Program Template dialog.
Navigate to the required Program
Template file (in an instrument folder)
and press Open to create a null
operation Program file.

n If the Program file already exists,
select File > Open. Navigate to the
required Program file and press
Open.

Remember You can also use the context menu in the Object Properties pane to create and open a Program file.

2 Configure the Channel Profile. Start by creating the required number of Program segments using the Insert
Segment button in the Toolbar. The following figure shows 4 or more segments have been created. The last
Segment is always a read-only END segment.

i) Configure the Segment type.
Select the method used to control
the setpoint value from the menu.

Segment type Graphic Function

Step The setpoint steps instantaneously from its current value to a
new value.

Dwell The setpoint remains constant for a specified period.

RampTime/RampRate The setpoint ramps linearly, from its current value to a new
value, either at a set rate (RampRate, single channel
Programs only), or in a set time (RampTime).

Table 2-3    Segment types

Segment

Segment

Validaton
period

Segment

iii) Configure the target setpoint value. This is the
value at which the next segment will start.

ii) Configure the duration of each segment.
Not applicable to RampRate segments.

Enter a duration  in hours, minutes, seconds
(49 days, 17 hours, 02 minutes, 47 seconds max).

Tip! If the duration should be 1 day or more, enter a number greater than 24, and then edit the field as required.
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2.3 QUICK START TO CONFIGURING A PROGRAM (Cont.)

5 Configure the Program Properties. The Program Name should, as a minimum, be edited from the default value.
Further configuration depending on the application may be required, but is beyond the scope of this section,
see How to... section.

i) Select the Program Name parameter and enter a name
used to identify the Program.

ii) see How to... section

6 Save the Program file, and return to LINtools. The Program file should look something like the figure below.

7 In LINtools, save the database file to update the download list, and download the instrument configuration using
the Download button in the Contents pane. The Program Template file and the Program file will automatically be
downloaded to the instrument along with the database file.
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2.4 QUICK START TO CONTROLLING THE PROGRAM

These instructions assume that the database file, .dbf, the Program Template file, .uyw, and the Program file, .uyy, have
already been downloaded to the instrument, and the database is running.

In the Programmer Editor

1 Connect to instrument using Connect command. This will attach to
instrument and reveal a number of buttons below the Segment grid and
Status page.

Note The configured segments will not be displayed until the
Program is started.

2 In LINtools, set PROGCTRL.File.Load TRUE. This will load the Program file defined in
PROGCTRL.File.ProgFile.

3 Press the Start button to run the Program, see Programmer Editor Help file. Observe as the Program Status area
changes to Green to indicate the Program is running. A scrolling vertical bar is used to show the current position
of the Program.

As the Program starts each segment, the Program History area records the configuration applied to the segment,
and any configured operations and user interactions, i.e. a configured Wait condition, or the HOLD button is
pressed. A date and time reference is included with each operation.

Note The Channel Setpoints area shows the current segment type in operation.

4 Use the buttons to control the Program currently running. Press

n HOLD to freeze the current setpoint value and the Program at its current position. The Program Status area
changes to Amber to indicate the Program is in a HELD state.

n RESTART to remove the HELD status and continue the Program from the current setpoint value and its
current position in the Program. The Program Status area returns to Green to indicate the Program is running.

n SKIP to move to the next segment immediately using the current setpoint value.

n ADVANCE to move to the next segment immediately setting the current setpoint value equal to the target
setpoint.

n JOG to display a list of time
periods used to change the
current position of the segment.
This can be used to increase or
decrease the length of the
current Dwell or Step segment.
This is only enabled if the
setpoint value in all segments
are not ramping.

n REDO to repeat the current
segment. This is enabled if the
Program is in a Held state.

n ABORT to terminate the current
Program. The Program Status
area returns to Grey to indicate
the Program is in Idle state.
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2.5 HOW TO...

In this section, you will be guided through additional tasks used to configure elements of a Program. These tasks will
help you when configuring the strategy in the instrument, and include instructions for displaying asserted Program
alarms on an Eycon Visual Supervisor.

2.5.1 Organise the display of Program alarms in an Eycon

When the Eycon is used to display the control of a Program in a T2550, it is possible to show the Programmer alarms.
Alarms asserted in the Programmer blocks can be automatically added to the list of Alarms shown on the Monitor
display of an Eycon by using the cached PROGCTRL block and the cached PROGCHAN block as shown. These
blocks will already be cached in the Eycon because this instrument may be used as the overall control of the Program.

Note If a AREA block is not configured, the Eycon Alarms button on the Monitor display will only show
PROGCTRL block alarms and events.

To configure the display of Program alarms

1 In LINtools, add an AREA block and a GROUP block (Organise
category) to the worksheet. Name the blocks.

2 In the GROUP block populate the Disp1 - Disp16 fields with the
PROGCTRL block and the PROGCHAN block.

3 In the AREA block, populate a Group1 - Group16 field as required
with the relevant GROUP block name.

4 Save, download and run the databases in the corresponding
instruments.

Any asserted alarm will now appear on the Monitor display of the
Eycon when the Alarms button is pressed.

Note This also applies to any other process critical block.

sp_prog

PROGCHAN blocks
(SP01C1, etc.)

Alarm asserted in
PROGCTRL block

(SP01, etc.)

GROUP block
name

EYCON FACEPLATE

GROUP Block

Disp1 - Disp16 Chan1 - Chan16

AREA Block

Group1 - Group16

Up to 16 groups per area

P R O G C H A N
SP01C1

PROGCTRL
SP01

OTHE R
BLOCKS
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Table 2-5-2    Wiring User Value and Digital Event outputs

2.5.2 Write User Values, and Digital Events Outputs

Configuring User Values, and Digital Events allows a specified value to be written to a wired destination as the
segment is started.

n User Values are a general purpose analogue values within the limits defined in the Programmer Wizard that can be
written to any Engineering Unit field (Eng).

n Digital Events are a general purpose digital values that can be written to any Digital field.

To write values in the database

1 In LINtools, wire the blocks as shown in the table below.

Remember You can use the context menu in the Object Properties pane to wire to and from other blocks in
the database.

2 In the Programmer Editor, enter the User Value, or select the Digital Event in the required segments of the
Program. These are the values that will be written to the wired destination.

When attached to the instrument, select the
User Value or Digital Event to show the
configured action as applied in the Program in
the lowest plot in the Chart pane.

Note The User Value limits and the user
configured Digital Event
enumeration are defined using the
Programmer Wizard in LINtools.

3 Save, and download the Database file, Program
Template file and Program  file.

Note If using a Project you may also have
to build the Instrument folder.

Source Destination Function

User Value configuration

(PROGCHAN) SP01C1.Monitor.Uval1 (AN_CONN) an_conn.PV1

(PROGCHAN) SP01C1.Monitor.Uval2 (AN_CONN) an_conn.PV2

(PROGCHAN) SP01C1.Monitor.Uval3 (AN_CONN) an_conn.PV3

(PROGCHAN) SP01C1.Monitor.Uval4 (AN_CONN) an_conn.PV4

Digital Event configuration

(PROGCHAN) (DG_CONN)
SP01C1.Monitor.Event.EventOut1 dg_conn.W Field1.Bit0

(PROGCHAN) (DG_CONN)
SP01C1.Monitor.Event.EventOut2 dg_conn.W Field1.Bit1

(PROGCHAN) (DG_CONN)
SP01C1.Monitor.Event.EventOut3 dg_conn.W Field2.Bit0

(PROGCHAN) (DG_CONN)
SP01C1.Monitor.Event.EventOut4 dg_conn.W Field2.Bit1

Note (Block type) blockname.page.field.subfield format.

Writes the value configured in the corresponding
User Value field for the required Segment of the
Program to the destination block field when the
segment is initiated.

Writes the On/Off  configured in the corresponding
Digital Event field for the required Segment of the
Program to the destination block field when the
segment is initiated.
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2.5.3 Configure a Wait (or Exit) condition

Configuring a Wait (or Exit) condition controls the Program in order to ensure specific conditions are achieved before
the Program can continue (or terminate).

Note If a Wait condition has been applied, the Advance and Skip buttons can be used to proceed to the next
segment.

To configure the required Wait (or Exit) condition

1 In the Programmer Editor, set the required Wait
(or Exit) conditions to On or the corresponding
user configured enumeration. Only conditions set
accordingly will react to changes in the strategy.

Note Exit conditions can only be applied to
segments that are not ramping the
setpoint, i.e. Dwell and Step.

When attached to the instrument, select the Wait
(or Exit) conditions to show the configured action
as applied in the Program in the lowest plot in the
Chart pane.

Note The user configured enumerations are
defined using the Programmer Wizard
in LINtools.

Source Destination Function

Programmer configuration

(DO_UIO) di_uio01.In (PROGCHAN) SP01C1.Monitor.CurrCond.Wait1

(DO_UIO) di_uio01.In (PROGCHAN) SP01C1.Monitor.CurrCond.Wait2

(DO_UIO) di_uio01.In (PROGCHAN) SP01C1.Monitor.CurrCond.Wait3

(DO_UIO) di_uio02.In (PROGCHAN) SP01C1.Monitor.CurrCond.Exit4

(DO_UIO) di_uio02.In (PROGCHAN) SP01C1.Monitor.CurrCond.Exit5

(DO_UIO) di_uio02.In (PROGCHAN) SP01C1.Monitor.CurrCond.Exit6

Note The rules specified using the SP01C1.Monitor.Cond.Waitn (or Exitn) and
SP01C1.Monitor.InvCond.Waitn (or Exitn) subfields determine how the Program will react if a
Wait (or Exit) condition is enabled in a segment, see LIN Block Reference Manual.

Table 2-5-3    Wiring Wait (or Exit) condition inputs

Writes the TRUE/FALSE value to the wired
SP01C1.Monitor.CurrCond.Waitn subfield. Segments
will Wait, according to the rules specified in the
SP01C1.Monitor.Cond.Waitn and
SP01C1.Monitor.InvCond.Waitn subfields.

Writes the TRUE/FALSE value to the wired
SP01C1.Monitor.CurrCond.Exitn subfield. Segments
will terminate according to the rules specified in the
SP01C1.Monitor.Cond.Exitn and
SP01C1.Monitor.InvCond.Exitn subfields.

3 Save, and download the Database file, and Program file.

Note If using a Project you may also have to build the Instrument folder.

2 In LINtools, wire the blocks as shown in the table below.

Note The SP01C1.Monitor.CurrCond.Waitn and SP01C1.Monitor.CurrCond.Exitn subfields can be wired to
an appropriate block type for the strategy.
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2.5.4 Configure Algorithm data

Algorithm data can be configured using a combination of the Algorithm File field in the Programmer Editor and the
wiring of the PROGCTRL block to the SFC_CON, RECORD, RCP_SET (and RCP_LINE), or DR_REPRT blocks.
These blocks hold the data used to populate the required algorithm.

The example below shows how the RECORD block can be used to read and write values to/from the Record file.

ii) Configure the block fields as below, and ensure the Record file is in the instrument folder and included in the
files to be downloaded. This will ensure the file is downloaded to the instrument.

Source Destination Function

Programmer configuration

(PROGCHAN)
SP01C1.Monitor.EventOut.Event3 (RECORD) rec_01.Put This will write the values from this block to the specified

RecordNo field in the Record file (.rcd) when the Digital Event is
set TRUE.

(PROGCHAN)
SP01C1.Monitor.EventOut.Event4 (RECORD) rec_01.Get This will read the values from the specified RecordNo field in the

Record file (.rcd) when the Digital Event is set TRUE.

Block.<Page>.Field.Subfield Value Function

Programmer configuration

(PROGCTRL) SP01.Config.AlgBlk rec_01 This is the RECORD block name used in conjunction with the
Algorithm File field configured in the Programmer Editor.

(RECORD) rec_01.FileName record01 Enter the name of the Record file (.rcd) used.
The Record file can only be written to or read by the Record block.

(RECORD) rec_01.RecordNo 1 Enter the number indexing the values from this block in the Record
file (.rcd).

Table 2-5-4b    Values for non-default block fields

Table 2-5-4a    Wiring Algorithm data control

To configure the algorithm data

1 In the Programmer Editor, set the Algorithm File field as required, i.e. record01, and save the Program.

2 In LINtools, configure the database.

i) Add and wire the blocks for this example as shown below.

PROGCTRL
PR01

RECORD
rec_01

Record
file

(record01.rcd)

ToFileName

Put values in
Record file

From
Config.AlgBlk

Wired from
Monitor.EventOut.Bitn  to

Put (see Note )

Note The Algorithm file specified in the Programmer Editor is loaded via the RECORD block. RECORD.Put
can be used to write values to the Record file (.rcd) at the users discretion. RECORD.Get can be used
to read values from the Record file (.rcd) at the users discretion.

Figure 2-5-4    Algorithm data control

PROGCHAN
PR01C1

T2550 DatabaseProgrammer Editor

Algorithm File field
(record01)

Get values from
Record file

3 Save and download the files to the instrument.

Note You can also use the Network Explorer if connected, to transfer files between the instrument and the
computer.
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2.6 TROUBLESHOOTING

Most Program problems can be resolved by inspecting the PROGCTRL block and the PROGCHAN block.

Note Most of the following instructions can be tried and applied during online reconfiguration. If
configuring the instrument strategy offline, remember it must be saved and downloaded to the
instrument along with the Program Template file and Program file where applicable before confirming
the operation.

Q Why does the Programmer Editor only show one END segment of the Program ?

A This is probably because the Program file did not successfully load before connecting to the instrument from the
Programmer Editor.

To resolve this, in the Programmer Editor, simply close the connection to the instrument, ensure the Program file
is loaded (PROGCTRL.Monitor.State indicates an initialised state, e.g. Idle, not Unloaded) and then press Online
Connect again. The Program file will be displayed as expected because it loaded before connecting to the
instrument.

Q Why is PROGCTRL.File.Alarms.Oob asserted ?

A This is the Out of bounds alarm. It is used to show that a PV value in the Program has exceeded the Low and/or
High Alarm value, as determined by the rules specified by the PROGCHAN.Monitor.HbType subfields in
conjunction with the Holdback + Alarm Value configured in the Programmer Editor.

Note An Out of bounds alarm remains asserted until the Program is reset, and the Program is in the Idle state.
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Note This could be caused if there is a mismatch between the  resources defined in the
Program Template file and the database, the Program Template file cannot be
found, i.e. not  downloaded to the instrument, or the Program Template file
specified in the PROGCTRL block and the Program do not correspond.

2.6 TROUBLESHOOTING (Cont.)

Q Why does the Program file fail to load ?

A This is probably because a problem exists somewhere in the
Program configuration, e.g. an error exists in the Program
file, an invalid PROG_WIZ compound , or Program
configuration.

Use this flow chart to diagnose problems.

Note Refer to the LIN Block Reference Manual for
details about the PROGCTRL.File.FileErr field.

Setpoint
Programming

Connect to the instrument via
both LINtools and the
Programmer Editor.

In LINtools, load the specified
Program file (change

PROGCTRL.File.Load from
FALSE to TRUE)

Are any alarms
in the PROGCTRL block

TRUE ?

No Yes

Yes

The selected Program file
contains errors as indicated in

PROGCTRL.File.FileErr , see
LIN Block Reference Manual.

Is
PROGCTRL.File.Alarms.Config

TRUE ?

Yes

The Program configuration is
invalid, as indicated in

PROGCTRL.File.FileErr , see
LIN Block Reference Manual.

No

No

Is
PROGCTRL.File.Alarms.BadFile

TRUE ?

Yes

Yes

Yes

Yes
Does

PROGCTRL.File.FileErr
show TmplFile ?

Yes

If problems persist,
contact help desk.

The Program file has
loaded successfully.

Press the Start button
to run the Program.

Repeat this for each alarm subfield
(PROGCTRL.File.Alarms.BadFile

and
PROGCTRL.File.Alarms.Config )

as it occurs.

No

No

No Does
PROGCTRL.File.FileErr

show Format ?

The number of channels in
Program does not match the
number of channels  defined

in the PROGCTRL block.

In the Programmer Editor,
configure the Program file.
In LINtools, configure the

database, save and
download all the files.

Is the Start button
in the Programmer Editor

enabled ?

No

In LINtools, run the
Programmer Wizard to make
sure sufficient properties are

applied to the Program
Template file and the database.

Yes
Does

PROGCTRL.File.FileErr
show GoBack ?

No

The Program file contains
an invalid GoBack

instruction, i.e. overlapping
Goback segment.

A conflict between the Program
Template file, the Program file,
and the database exists, see

Note below .

Does
PROGCTRL.File.FileErr

show AlgBlk ?

No

No Yes

A conflict between the
Algorithm file specified in the
Program file, and the AlgBlk
defined in the PROGCTRL

block exists.

The Program file contains
more segments than

supported by the
database.

Does
PROGCTRL.File.FileErr

show TooBig ?

Does
PROGCTRL.File.FileErr

show NoFile ?

The Program file does not
exist in the instrument,

and must be downloaded.



T2550 PAC TUTORIAL/USER GUIDE

HA029723
Issue 2  Nov 12

Appendix A
Page A - 1

APPENDIX A FTP (FILE TRANSFER PROTOCOL) SERVER
If the instrument is connected, as part of a Ethernet Network, the Data Recording files, .uhh, can be archived to a
defined FTP Server. Using the Instrument Properties dialog, .uhh files are pushed from the instrument to an archive
directory configured in a specified FTP Server.

Note A number of FTP Servers are available. This section describes the installation and configuration using
the default settings of the Internet Information Services (IIS) FTP Server supplied with the Windows XP
Operating system, see  Microsoft IIS Documentation help file for details.

A1.1 ADDING AN FTP SERVER

For the purpose of these instructions, we will assume that the computer is using a Windows XP Operating System and
has an  IP Address of 192.168.111.254.

To install an FTP Server

1 Launch the Windows Control Panel. Click a  Start  > Control Panel.

2 Open the Add/Remove Programs dialog, then select Add/Remove Windows components from the left column.
This launches the Windows Component Wizard.

3 Select the Internet Information Services (IIS).

Note Ensure the File Transfer Protocol (FTP) Service is selected, by pressing the Details button to display
the Internet Information Services (IIS) dialog used to select this service.

4 Use the Next button to continue the Windows Component Wizard. This launches the install process and displays
a confirmation dialog when complete. This installation creates the default file structure required for FTP.

Figure A1-4    Install the FTP Site
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A1.1 Adding AN FTP SERVER (Cont.)

Now that the server has been installed, it must be configured

1 Launch the Windows Control Panel. Click a  Start  > Control Panel.

2 Open Administrative Tools, then launch the Internet Information Services (IIS).

3 Expand the Local Computer icon and the FTP Site icon to display the Default FTP site folder.

4 Select the Default FTP site folder to show the context menu and select Properties to display a dialog. Use this dialog
to set the identification parameters for your server. The server and domain names and the IP address are optional.

l Select the FTP Site page. This allows you to configure the identification for the FTP Site.

Description. This name is primarily for
identification and organizational purposes, and
does not need editing.

IP Address. This is the IP address of the local
computer connected to the network.

TCP Port. This determines the port on which the
service is running.

IMPORTANT The TCP Port must be set to 21.

l Select the Home Directory page. This allows you to
configure the path to the FTP directory or destination
URL. The syntax must match the selected path type,

For a local FTP directory, use the full path; for
example, c:\inetpub\ftproot , by default. Use the
Browse button to select a local directory rather than
typing the path.

For a network share, use a Universal Naming
Convention (UNC) server and share name; for
example, \\Webserver\Htmlfiles.

Note The Write box must be set TRUE.

5 Press OK to confirm the changes to the configuration of the FTP Site and to close the Properties dialog.

l Select the Security Accounts page. This allows
you to configure remote access to your specified FTP
Server.

Allow Anonymous Connections. Set Allow
Anonymous Connections FALSE to only allow
connections to the FTP Server from Windows User
accounts that exist on this computer. When FALSE
all parameters are disabled, greyed out.

Note Anonymous connections, Allow Anonymous
Connections set TRUE, are permitted, but not
recommended
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1.4 Adding AN FTP SERVER (Cont.)

Check to see if files are transferring,

1 Open Windows Explorer. Click a  Start  > Programs > Accessories > Windows Explorer .

2 Locate and open the FTP directory configured in the Home Directory page of the Default FTP Site Properties
dialog. This will be at c:\inetpub\ftproot if the default was used.

3 Open the folder used to identify the instrument generating .uhh files, as configured in the Instrument Properties
dialog, and the folder identifying the group of values recorded in this .uhh file.

4 With the c:\inetpub\ftproot  FTP directory open, .uhh files appear as they are transferred from the instruments’
internal flash memory.

Note Sub folders can be created in the default c:\inetpub\ftproot FTP directory, but this must also be
configured in the Directory field of the Archiving category in the Instrument  Properties dialog.

IMPORTANT If the .uhh files are not appearing in the configured archive directory, open LINtools and
inspect the RARCDIAG block. This will provide information for diagnosing why the .uhh files are not being
archived.
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